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1. Tiltenkt bruk og advarsler 

Tiltenkt bruk 
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Cortrium Apex er en programvare som brukes til å klargjøre Cortrium C3w/C3⁺ Holter-monitor før bruk på 

en ny pasient, administrere pasientopplysninger, bestille og vise EKG Holter-rapporter, laste ned opptaket i 

.EDF-format og vise hele EKG-opptaket. Opptaksdata kan dessuten lastes ned og importeres til 

tredjepartsprogramvare, hvor de kan analyseres. Programvaren kan brukes med både Microsoft Windows 

og MacOS (se minstekrav punkt 12). 

 

 

Tiltenkte brukere 

Programvaren er beregnet på bruk for helsepersonell i privat praksis, på klinikk og i sykehus samt til 

fjernmonitorering. 

 

 

Advarsler 

• Dette produktet må brukes bare i samsvar med tiltenkt bruk som nevnt i denne bruksanvisningen. 

• Brukerne av dette produktet er unike og må aldri dele passord med andre. 

• Skjermbildene i programvaren kan inneholde sensitiv informasjon og må unngås. 

• Når data deles utenfor systemet, skjer dette på brukerens eget ansvar. 

• Hvis det oppstår alvorlige hendelser i forbindelse med programvaren, bør lokale myndigheter og 

Cortrium kontaktes på support@cortrium.com umiddelbart. 

 

 

Ytterligere informasjon  

Vær oppmerksom på at programvareversjon som vises på skjermbildene i denne håndboken, kan henvise til 

tidligere versjoner av programvaren. 

F.eks. hvis det ikke er gjort endringer i brukergrensesnittet, kan versjonen som vises på skjermbildene, 

være eldre enn gjeldende versjon av programvaren, men funksjonaliteten er identisk.  

 

For brukere som har aktivert integrasjoner, kan skjermbilder og bruk variere. Instruksjoner om bruk av 

disse integrasjonene finnes i vedlegg I sist i dette dokumentet. 

 

Kontraindikasjoner 

Apex må ikke brukes til forberedelse av pasienter med livstruende tilstander som kan føre til umiddelbar 
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fare. 

2. Installasjon 

 

a. Du er blitt invitert til Cortrium Apex via e-post. Åpne e-postinvitasjonen på en datamaskin 

hvor du vil installere Cortrium Apex. 

b. Klikk på lenken i e-postinvitasjonen for å angi et passord. 

c. Bekreft passordet.  

d. Velg «Go to next step» (Gå til neste trinn) for å fortsette nedlastingen.  

e. Last ned installasjonsfilen for Windows eller MacOS.  

f. Når nedlastingen er fullført, kjører du installasjonsfilen.  

g. Når installasjonen er fullført, åpnes Cortrium Apex automatisk.  

h. Du kan nå logge på med e-postadresse og tilhørende passord og begynne å bruke Cortrium 

Apex. 

 

Vær oppmerksom på at Cortrium Apex krever internettforbindelse. Du får ikke logget på eller brukt 

Cortrium Apex uten internettforbindelse.
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3. Logge på Cortrium Apex 

For å bruke Cortrium Apex må du først ha et brukernavn og passord. Hvis du er administrator ved 

institusjonen, har Cortrium konfigurert dette for deg. Hvis du ikke er administrator og ennå ikke 

har et brukernavn og passord, kan administratoren ved institusjonen konfigurere dette. 

 

Når du har installert Cortrium Apex og fått brukernavn og passord, kan du fortsette med følgende 

trinn: 

• Åpne Cortrium Apex på datamaskinen ved å dobbeltklikke på Cortrium Apex-ikonet. 

• Klikk på «Sign in» (Logg på). (Hvis du har glemt passordet, klikker du på «Forgot your 

password» (Glemt passordet).) 
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• Skriv inn brukerinformasjonen, og trykk på «Continue» (Fortsett). 
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3.1 Holde brukerne pålogget på lokale datamaskiner i Cortrium Apex 
 

•  Brukere kan forbli pålogget lokalt hvis OS-sikkerhet er aktivert. 
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4. Klargjøre C3w/C3⁺ til en ny pasient 

Hvis C3w/C3⁺ allerede er blitt brukt til å registrere et langtids-EKG, må du lese punktet «Bestille en Holter-

rapport» før du følger trinnene i dette punktet. 
• Velg knappen «Open device» (Åpne apparat). 

 
• Koble C3w/C3⁺ til datamaskinen ved hjelp av den medfølgende USB-kabelen.  

(Hvis du bruker et Apple-produkt, kan det hende du trenger en USB-omformer.)
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• Cortrium Apex viser informasjon om det tilkoblede apparatet og eventuelle data som er lagret på 

den. 

• Velg «Erase all and prepare device for new patient» (Slett alt, og klargjør apparatet til ny pasient). 

• Fyll ut relevant pasient- og registreringsinformasjon: 
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• Klikk nå på «Save to Device» (Lagre på apparat). Alle pasientopplysninger eller opptak som er lagret 

på apparatet, slettes, og den nye pasientinformasjonen lagres i systemet. 

• Du kan nå løse ut apparatet via knappen «Safely unplug device» (Koble fra apparatet på en sikker 

måte) på høyre side. 

• C3w/C3⁺ er nå klar til opptak på en ny pasient. 

• Hvis du har skrevet inn feil pasientinformasjon, kan du redigere informasjonen ved å klikke på «Edit 

patient information» (Rediger pasientinformasjon). 
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5. Bestille en Holter-rapport 

Med Cortrium Apex kan du sende opptak til analyse og laste ned Holter-rapporten så snart den er 

tilgjengelig. Når et apparat returneres med et opptak, klikker du på knappen «Open Device» (Åpne apparat). 

Nå kan du velge neste trinn ved hjelp av knappen «Actions» (Handlinger). Som standard har du følgende to 

alternativer: 

 

• Bestill Holter-rapport. 

• Last opp og eksporter som EDF. 

 

 
 
 
 

For å bestille Holter-rapporten klikker du på knappen «Actions» (Handlinger) og deretter på «Order Holter 

report» (Bestill Holter-rapport).  

Du vil bli møtt av et skjema som lar deg bekrefte bestillingen eller velge flere alternativer for analysen din.   
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Dine tilleggsalternativer er:  

• HRV:  Holter-rapporten vil inkludere vurdering av hjertefrekvensvariabilitet (HRV) 

• AV-blokk:  Vurdering og gradering av AV-blokk av seniorspesialist 

• Ekspress: Levering samme dag av bestillinger lagt inn før kl. 12.00 CET 

 

Når du er fornøyd med valget av analysealternativer, kan du klikke på «Confirm» (Bekreft) for å fortsette.  

 

Hvis du har valgt tillegg til analysen din, vil du få en melding som informerer om dine valg vil medføre 

ekstra kostnader.  

Klikk på «Bekreft» for å fortsette. 
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Opptaket lastes nå opp.  
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Etter at opptaket er lastet opp, gjøres Holter-rapporten tilgjengelig når den er analysert. Apparatet kan 

allerede klargjøres til en ny pasient så snart opptaket er lastet opp.   

 

Avhengig av kontoinnstillingene vil du bli informert via e-post når Holter-rapporten er klar til å vises. Apex 

viser også nylig utfylte rapporter med en rød prikk, slik at de enkelt kan identifiseres. 

 

I neste punkt forklares det hvordan du kan vise Holter-rapporten så snart den er analysert, og hvordan du 

kan vise hele opptaket rett etter opplasting. 
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6. Vise Holter-rapporter og hele opptaket 

I Cortrium Apex kan du vise Holter-rapportene som PDF, og du kan vise hele opptaket rett etter at du har 

lastet det opp til analyse. Nedenfor beskrives det hvordan du viser Holter-rapportene, og i punkt 6.2 

forklares det hvordan du bruker «Recording viewer» (Opptaksleser).   

  

6.1 Vise Holter-rapporter 
 

Når et opptak er analysert, kan du vise Holter-rapporten som PDF. 

Dette gjør du ved å gå til menypunktet «Recordings» (Opptak) og klikke på den aktuelle pasienten. Du 

kan da se  

PDF-rapporten på siste linje under Holter-rapport. Holter-rapporten åpnes i nettleseren.  
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6.2 Opptaksleser 

Hvis du vil vise hele opptaket etter at det er lastet opp, klikker du på opptak og velger den pasienten du 

vil se opptaket til (se første skjermbilde i punkt 6.1). Nå kan du bruke opptaksleseren ved å trykke på 

knappen «View» (Vis).  

 

 

 
Opptaksleseren åpnes.  

 

• Leseren laster inn 1 minutt med data og viser 7 sekunder med EKG om gangen. 

• Med de merkede interaktive funksjonene kan du velge den dagen, den timen, det minuttet og det 

sekundet du vil vise i opptaket. Velg klokkeslett, og klikk på søkeikonet for å bekrefte innstillingen. 

• Ved å holde inne og dra i den lyseblå linjen nederst i leseren kan du se de 60 sekundene rundt det 

valgte tidspunktet.  

• Ved å klikke på navigasjonspilene eller dra visningen til kanten, kan du bevege deg framover og 

bakover i opptaket. 

• Hvis signalamplituden er lav, kan du dessuten øke den ved hjelp av zoomfunksjonen. 
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Klikk på «x» (x) øverst til høyre for å lukke opptaksleseren.  

 

6.3 Verktøy for redigering av sammendrag  

Når du har mottatt rapporten, kan du redigere sammendraget hvis du har spesifikke formuleringer eller 

opplysninger du ønsker å ta med. 

Dette gjør du ved å klikke på opptak og velge den pasienten du vil redigere rapportsammendraget for. 

Nå kan du bruke verktøyet for redigering av sammendrag ved å trykke på knappen «Edit report» (Rediger 

rapport) på siste linje under Holter-rapporten. 

 

7. Redigere pasientopplysninger og se opplysninger om opptak 

Når du har valgt menypunktet «Recordings» (Opptak), kan du klikke på et opptak for å åpne et sammendrag 

med tilhørende opplysninger. 

Sammendraget av opptakene inneholder opplysninger som 

• opptakets varighet 

• startdato og -klokkeslett 

• avledningsfrakobling, dvs. perioder hvor elektrodene ikke var i kontakt med kroppen 

• hendelser, når pasienten har trykket på knappen for å indikere symptomer eller en hendelse 

• prøvetakingsfrekvens for EKG-signalet 
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• informasjon om pacemakeren hvis dette ble notert da apparatet ble klargjort til en ny pasient 

  

 
Du kan redigere pasientinformasjonen ved å klikke på knappen «Edit» (Rediger). 
 

 

 

Du kan lagre justeringene ved å klikke på knappen «Save» (Lagre). 
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8. Slette et opptak 

Hvis du vil slette et opptak, åpner du delen «Recordings» (Opptak) og klikker på opptaket du vil slette.  

Klikk nå på «Delete recording» (Slett opptak) øverst til høyre. Når du har skrevet inn pasientnavnet, må du 

bekrefte slettingen ved å trykke på «Delete» (Slett). 
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9. Laste ned EDF-fil 

EDF-filen kan lastes ned før du bestiller Holter-rapporten, eller etter. De to forskjellige tilfellene beskrives i 

de neste punktene.  

 

9.1 Laste ned EDF-filen før du bestiller Holter-rapporten 
 

Følg disse trinnene for å konvertere et opptak til EDF-format: 

 

• Koble C3w/C3+ Holter-monitor til datamaskinen, og trykk på knappen «Open device» (Åpne enhet) 

på menyen til venstre.  

• Klikk på knappen «Actions» (Handlinger), og velg «Upload and export as EDF» (Last opp og eksporter 

som EDF). 

 
 

 
 

• Opptaket overføres til Apex. 

• Når overføringen er fullført, endres knappen «Actions» (Handlinger) til «View» (Vis).
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• Klikk på knappen «View» (Vis) for å se opptaksoversikten. 
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• Underpunktet «Download report in EDF format» (Last ned rapport i EDF-format) viser følgende 

informasjon: 

o Mens opptaket konverteres, vises framdriften. 

o Når EDF-filen er klar, klikker du på knappen «Download» (Last ned) for å lagre EDF-filen på 

datamaskinen.  

 
 

9.2 Laste ned EDF-fil etter at du har bestilt en rapport 

Slik gjør du hvis du nettopp har bestilt en rapport av et opptak og nå ønsker å laste ned opptaket i EDF-

format: 
• Når apparatet er tilkoblet, klikker du på menypunktet «Open device» (Åpne apparat) og deretter på 

knappen «View» (Vis) ved siden av opptaket. 

• På skjermbildet «Recording details» (Opptaksopplysninger) klikker du på «Download» (Last ned) for 

å laste ned EDF-filen. 

 

Hvis du vil laste ned et tidligere opptak i EDF-format, 

• klikker du på menypunktet «Recordings» (Opptak)  

• klikker du på opptaket du ønsker å laste ned i EDF-format 
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• og klikker deretter på «Download» (Last ned) som illustrert nedenfor 

 

10. Logge av Cortrium Apex 

Det er viktig å huske å logge ut av programvaren ved å klikke på knappen «Log out» (Logg av) nederst til 

venstre. 

 

Cortrium Apex logger automatisk ut av brukerkontoen din etter en lengre periode uten aktivitet.  

 

Hvis institusjonen har flere brukere med separate kontoer for Cortrium Apex, men brukerne arbeider fra 

samme datamaskin, må du sørge for å logge av Cortrium Apex når du er ferdig med oppgavene dine. 

 

11. Programvareoppdateringer 

Når programvaren startes, søker den automatisk etter tilgjengelige oppdateringer og installerer dem 

umiddelbart. 
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12. Tekniske minstekrav 

Minstekravene til bruk av Cortrium Apex er følgende: 

• Windows 10 eller MacOS 11 Big Sur (Intel). 

• 1280 x 960 piksel skjermoppløsning. 

• 4 GB RAM. 

• 5 GB ledig plass på harddisken.  

• internettforbindelse 

 

Cortrium Apex krever en internettforbindelse. Forbindelsens opplastingshastighet avgjør hvor lang tid det 

tar å laste opp et opptak når du bestiller en rapport eller konverterer opptaket til et annet format. 

Nedlastingshastigheten avgjør hvor lang tid det tar å laste ned et konvertert opptak. 

Nedlasting og visning av en rapport tar vanligvis bare noen få sekunder på en 10 Mb/s internettforbindelse. 

 

13. Feilsøking 

 
13.1 «The device seems to be set up for a patient...» (Apparatet ser ut til å være 

konfigurert for en pasient …) 

Hvis du ser advarselen: «Warning. The device appears to be set up for a patient, but we cannot find the 

patient data in the system. Please set up a patient for the records» (Advarsel. Apparatet ser ut til å være 

konfigurert for en pasient, men vi finner ikke pasienten i systemet. Konfigurer en pasient for postene), 

klikker du på knappen «Add Patient Information» (Legg til pasientinformasjon) for å konfigurere apparatet 

til bruk med Cortrium Apex. Postene på apparatet fjernes ikke. 

 

13.2 Opptakssammendraget viser «n/a lead off» (– avledningsfrakobling) eller «n/a 

events» (– hendelser) 

Hvis opptakssammendraget viser «n/a lead off» (– avledningsfrakobling) eller «n/a events» (– hendelser), 

skyldes dette at fastvaren på det tilkoblede C3w/C3⁺-apparatet er en versjon som ikke støtter umiddelbar 

avledningsfrakobling eller hendelsessammendrag. Opptaket er imidlertid fortsatt gyldig. 
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13.3 Internettforbindelsen ble brutt 

Hvis du ser meldingen «Cortrium Apex is having trouble accessing the Internet» (Cortrium Apex har 

problemer med å få tilgang til internett), er det mulig at internettforbindelsen er brutt eller bortfalt. 

Kontakt institusjonens IT-support eller internettleverandøren for å få hjelp til å gjenopprette 

internettforbindelsen. 

 
● Cortrium Apex forsøker automatisk å koble seg til internett igjen. En melding angir når 

neste tilkoblingsforsøk vil finne sted. 

● Hvis det ikke er noen internettforbindelse når Cortrium Apex startes, vises en melding 

om at du ser ut til å være frakoblet. 

● Hvis du var i gang med å overføre et opptak da internettforbindelsen ble brutt, er det 

mulig du må starte overføringen på nytt når forbindelsen gjenopprettes. 

 
13.4 Apex er nylig installert, men åpnes ikke 

Dette problemet kan oppstå på grunn av en brannmur som blokkerer Cortrium Apex-programvaren. Hvis 

Apex ikke starter på grunn av en brannmur, må du sørge for at nettstedslenkene i punkt 16 «Erklæring om 

infrastruktur» er blokkert eller «hvitlistet» i brannmuren. Kontakt institusjonens IT-avdeling for å få 

support.  

 
 

14. Sikkerhetsinformasjon 

Brukeradministrasjon 
• Hver Cortrium Apex-bruker må bruke sin egen konto.  

Du kan opprette og slette så mange brukerkontoer du trenger, på ps://apex.cortrium.com. 
Det er viktig at du er i stand til å bestemme og regulere hvem som har tilgang til pasientenes 
sensitive opplysninger. 
 

Passord 
• Sørg for at du bruker et sikkert passord.  

 
• Ikke del brukernavn og/eller passord med andre. 

 
• Unngå å bruke samme passord for flere kontoer. 

Hvis du bruker det samme passordet flere ganger, kan det føre til at en konkurrent får tilgang til 
alle systemene og datamaskinene dine hvis bare ett passord blir kompromittert. 

 

https://apex.cortrium.com/
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• Husk å logge av Cortrium Apex. 
Hvis du forblir pålogget, vil andre brukeres handlinger i systemet se ut som om de er dine. 

 
 
Kryptering og ekstra beskyttelse 
Før du installerer Cortrium Apex på en datamaskin, anbefaler vi deg å gjøre følgende: 
 

• Aktiver diskkryptering. 
Hvis datamaskinen blir mistet eller stjålet, vil ikke sensitive data på datamaskinen kunne leses. 

 
• Aktiver automatiske systemoppdateringer. 

Øker sjansen for at datamaskinen holder seg oppdatert med sikkerhetsoppdateringer. 
 

• Aktiver innebygd sikkerhetsprogramvare (f.eks. Windows Security) hvis det er tilgjengelig. 
• Brannmur og programvare mot spionprogrammer, phishing og virus er innebygd i Windows. Vi 

anbefaler på det sterkeste at du aktiverer dette. 
 
 

15. Etiketter og symboler 

Nedenfor følger en oversikt over etiketter og symboler som finnes i Cortrium Apex: 
 

 
 
 
 

 

Symbol Navn Krav/merknad 

 

Produksjonsdato ISO 15223-1 

 

Produksjonssted 
 

ISO 7000 - 3082 

 

Se bruksanvisning/hefte ISO 7000 - 1641 

Eksempel på etikett 
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Forsiktighetsskilt ISO 7000 - 0434A 

 

CE-godkjent apparat med 
identifikasjonsnummer for meldt organ 

MDR (EU/745/2017) 

 

Medisinsk utstyr ISO 15223-1:2021 

 

16. Erklæring om infrastruktur 

Cortrium ApS erklærer at produktet Cortrium Apex er distribuert i Microsoft Azure-skytjenesten. Noen 
av nettadressene er avhengig av hvor produktet brukes. Tabellen nedenfor inneholder adresser som 
brukes av systemet: 

 
Nettadresse  Beskrivelse  
api.apex.cortrium.com  API for Cortrium Apex.  
viewer.apex.cortrium.com  API for Cortrium opptaksleser. 
apex.cortrium.com  Administratorgrensesnitt for Cotrium 

Apex.  
client.apex.cortrium.com  Nettklient for Cortrium Apex.  
login.cortrium.com  Auth0-endepunkt for pålogging.  
assets.apex.cortrium.com  Nedlasting av ressurser som Desktop 

Client.  
support.cortrium.com  Nettsted for support.  
cortriumukrecordingapex.blob.core.windows.net  Lagring av opptak (Storbritannia, 

sør).  
cortriumfrrecordingapex.blob.core.windows.net  Lagring av opptak (Frankrike, midtre).  

cortriumeurecordingapex.blob.core.windows.net  Lagring av opptak (Tyskland, vestre 
midtre).  

cortriumaurecordingapex.blob.core.windows.net  Lagring av opptak (Australia, øst).  

rt.services.visualstudio.com 
dc.services.visualstudio.com  

Brukes av Microsoft Azure 
Application Insights (telemetri).  

 
 
Port 443 (HTTPS) må åpnes for alle nettadressene ovenfor. De første 7 reglene på denne 
listen kan forenkles ved hvitlisting av hele Cortrium-domenet (*.cortrium.com). Dette 
reduserer også risikoen for å måtte gjøre framtidige justeringer når listen endres. 
  

http://api.apex.cortrium.com/
http://api.apex.cortrium.com/
http://client.apex.cortrium.com/
http://client.apex.cortrium.com/
http://apex.cortrium.com/
http://apex.cortrium.com/
http://client.apex.cortrium.com/
http://client.apex.cortrium.com/
http://login.cortrium.com/
http://login.cortrium.com/
http://assets.apex.cortrium.com/
http://assets.apex.cortrium.com/
http://support.cortrium.com/
http://support.cortrium.com/
http://cortriumukrecordingapex.blob.core.windows.net/
http://cortriumukrecordingapex.blob.core.windows.net/
http://cortriumukrecordingapex.blob.core.windows.net/
http://cortriumukrecordingapex.blob.core.windows.net/
http://cortriumukrecordingapex.blob.core.windows.net/
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Vedlegg I 

i. Tilgjengelige integrasjoner  

Følgende integrasjoner er landsspesifikke og derfor ikke aktivert for alle kunder: 

• GDT-pasientfil 

Gjør at Apex kan sette opp en pasient ved hjelp av en GDT-pasientfil. 

• DICOM-innkapslet rapport 

Gjør at Apex kan laste ned en rapport innkapslet i DICOM-formatert pasientinformasjon. 

• CPR-pasientoppslag 

Gjør at Apex kan sette opp en pasient ved hjelp av et dansk CPR-nummeroppslag. 

• Pasienthenvisning 

Pasienthenvisningsprosessen gjør det mulig for helsepersonell å legge ved og administrere 

henvisningsdokumenter når de bestiller et opptak. Dette sikrer at relevant 

pasientinformasjon kan gjennomgås eller faktureres under analyse- og 

rapporteringsprosessen. 

• Rapportgodkjenningsflyt 

Rapportgodkjenningsflyten sikrer at rapportene gjennomgår en strukturert gjennomgang av 

en tredjepartsgodkjenner i prosessen før de leveres til rekvirenten. 

• Oppslag og levering av rapporter for Nereida-pasienter 

Denne integrasjonen muliggjør pasientoppslag og automatisk henting av rapporter fra det 

tredjeparts Nereida-pasientsystemet. 
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ii. GDT-pasientfil 

• Klikk for å velge eller dra GDT-pasientfilen til GDT-inndatafeltet i Apex.  

• Når filen er lastet inn, fylles pasientinformasjonen ut. 

• Informasjon som er lastet inn, kan ikke redigeres. 
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iii. DICOM-innkapslet rapport 
• Hvis du vil laste ned DICOM-innkapslet rapport, klikker du på nedlastingsknappen i Holter-

rapportdelen under den valgte pasienten. 

• Når du har klikket på knappen, er filen lastet ned. Filendelsen er .DCM 
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• Stasjonsnavnet er som standard maskin-/datamaskinnavnet. Dette kan tilpasses i den 

individuelle brukerprofilen under Rediger konto. 
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iv. CPR-pasientoppslag 

• Skriv inn pasientens danske CPR i feltet, og trykk på «Search» (Søk). 

• Pasientinformasjonen hentes fra CPR-registeret. 

• Den hentede informasjonen fylles ut i pasientinformasjonsfeltene. 

• Informasjon som er lastet inn, kan ikke redigeres. 
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v. Kun opplasterrolle 

 
• Når den er aktivert for en bruker, kan brukeren kun laste opp og bestille rapporter uten å se 

pasientopplysninger eller rapporter.  
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vi. Active Directory-integrasjon 

 
• Når påloggingsskjermen er aktivert for en organisasjon, vises en tilpasset enkeltpåloggingsskjerm for 

den organisasjonen. Nedenfor ser du Cortriums påloggingsskjerm. Den faktiske 
påloggingsforespørselen kan se annerledes ut. 
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vii. Pasienthenvisning 

 
• Hvis Henvisningsintegrasjon er aktiv, vises alternativet for å laste opp en henvisnings-PDF-fil. 
 
• Klikk på Velg fil, og velg riktig pasienthenvisnings-PDF fra datamaskinen. 

 
• Henvisnings-PDF-en legges automatisk ved pasientopptaket ved opplasting. 

 
 

 

 
 
 
 
 
 

• Hvis Henvisningsintegrasjon er aktiv og et opptak er bestilt, kan henvisningen nås under 
opptaksdetaljer. 
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• En blå sirkel på et opptak i visningen «Recordings» (Opptak) indikerer at en vedlagt henvisning ennå 
ikke er lastet ned eller sett for den spesifikke rapporten. 
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viii. Rapportgodkjenningsflyt 

 

• Hvis Godkjenningsintegrasjon er aktiv og et opptak er bestilt, vil rapporten være tilgjengelig for et 
organisasjonsmedlem med godkjenningsrettigheter etter analyse. 
 

• Rapporter som venter på å bli godkjent, kan ses ved å velge «Awaiting Approval» (Venter på å bli 
godkjent). 

 
• Hvis Henvisningsintegrasjon er aktiv, indikerer en blå sirkel på et opptak i visningen «Recordings» 

(Opptak) at en vedlagt henvisning ennå ikke er lastet ned eller sett for den spesifikke rapporten. 
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• Rapporter som venter på å bli gjennomgått, kan åpnes og gjennomgås av et organisasjonsmedlem 
med godkjenningsrettigheter ved å åpne opptaksdetaljene og velge «Gjennomgå rapport». 
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• Godkjenneren vil ha muligheten til å gjennomgå rapporten og funnene og legge til 
rapportsammendraget. 
 

• Når rapportsammendraget vises, legges informasjon om godkjenneren til i sammendraget, sammen 
med muligheten til å legge til underlagsnotater for rapporten. 

 
• Når rapporten er gjennomgått, kan den godkjennes ved å klikke på «Godkjenn rapport». 

 
• Når rapporten er godkjent, leveres den til rekvirenten. 

 
• Hvis en rapport ikke kan godkjennes, kan du kontakte Cortriums kundeservice med CAS-ID 

(oppført under Holter-rapport om opptaksdetaljene). 
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ix. Oppslag og levering av rapporter for Nereida-pasienter 

 
 

• Hvis Nereida-pasientoppslag er aktivert og omslagskortnummeret angis, utføres et pasientoppslag og 
Apex-enhetsoppsettet fylles ut med pasientinformasjonen. 

 
• Hvis automatisk rapportlevering i Nereida er aktivert, vil fullførte rapporter være tilgjengelige for 

automatisk henting. 
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